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In this class you will learn how to:

- Create Templates

« Customize themes in the Design tab
 Insert and format charts and tables
«  Conduct a Mail Merge

« Insert a Watermark



CREATE A TEMPLATE

Dacument10 - Word ? = [m] X

Desimone, Elizabeth

New

Search for online templates pel

Suggested searches:  Business Cards  Flyer| Letters  [fducation

To create a template, Click

Resumes and Cover Letters  Holiday

- Document10 - Word ? —DSimoi E‘iml:h 7\ \\?-\ . {
File > New. N\
New e
Choose your category or £5 vome | teter o
Sea rCh by keyWO rd . We’ re Pinstripes letterhead Category \/ &
go i n g to go W it h Lette rs . ::;:es and Cover Letters : Swirl color letterhead
Scroll to your chosen N e
template and double click. o :
Then click Create. e :
VB Lesson 5.3 Comple... :::; ;0
»ﬁ Lesson 5.2 Comple... Photo Albums 9
- =
w] Lesson 3.2 Complete Annual 7
/é +| Birthday 6
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CUSTOMIZE THEMES

Ea) = m}

Document12 - Word ols

Home Insert Layout References Mailings Review View Design | Layout 2 Tell me.. Desimone... }-"jr.Share

Title TITLE = Paragraph Spacing = D D
iy 1 - @Eﬁ‘ecs'
— Colors Fonts Watermark Page Page
=" - + @ SetasDefault - Color - Borders
= | Formatting Page Background ~
b2 3 e A e 5 B T
Aa’] AaE| Aa’% Aoi|
mmm=EE EmsmEm EmEmmE EmsmEm
Office Facet Integral lon
Click the Design tab Ao 2] e [2o])
. mmmmEm =mmEm; EmEmsE EmmmE
lon Board... Organic Retrospect Slice ST ZIP Code]

, fo] ] (=0 o
To choose a preset Theme, click 1

o B le]

Themes and choose a theme e
from the dropdown menu. A ] I

Crop Damask Depth Dividend -

Reset to Theme from Purple graphic letterhead Template

g Browse for Themes...
== t Name]
’!_'E Save Current Theme...
p—— 1 ) stationery just the way itis. But you can add your own

personal touch in almost no time.

Want to update the logo at the top of the page? Single click it to selectit. Once
selected, do a single right mouse click to get the shortcut menu. Select “Change
Picture” from the menu and choose an appropriate file!

R

a1
1
+
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To customize a theme,
click on the tools on
the right side of the
Document Formatting
group.

These tools include
Colors, Fonts,
Paragraph Spacing, and
Effects.
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CUSTOMIZE THEMES

Document12 - Word

References

Layout Mailings

Flice Vi Sii.

Table Toals
[ |
|

TITLE H ;‘ParagraphSpacing'
vERDwG | O] Effects -
Colors Fonts
o - @ Setas Default
Document Formatting Custom
L 15.1.2 —————
- Office
. I NI Office
] I NN  Office 2007 - 2010
. I T Grayscale
I Eiue Warm
{_?lrleelhAdd]reSS, City, ST ZIP Code] N EEEEE Elc
elephone
- [Email] I NN Bl
I NN Blue Green
I T Green
N I TR Green Yellow
: [Date] W T P Velow
] I TN Vellow Orange
N ecipieni lame; range
Recipient N Orang
~ [F{g'“*ﬂ : B NN Orange Red
- ompany
. [Street Address] N W WU Red Orznge
_ [City, ST Zip Code] N EETEE e
) I N FRed Violet
" I violet
: I . Violst |
I TN Median
. . . | |
. We love the lock of this stationery just the way Paper
N personal touch in almost no time. Customize Colors...
. Want to update the logo at the top of the page? Single click it to selectit. Once
N selected, do a single right mouse click to get the shortcut menu. Select "Change
Picture” from the menu and choose an appropriate file!
Pagelof1 183words [[2 2§ E]

J Tellme... Desimone.

® a1 0

Watermark Page Page
o Calor - Borders

Page Background

B -1

g_ Share




CHARTS

Document? - Word = = O

Design Layout References Mailings Review View @ Tell me what you want to do... Desimane, Elizabeth }-" Share
N — -
B D r\o) =] SmartArt ol store W E’ﬂ =X + [ Header
O 4 11 Chart & L [2] Footer~

Pages Table Pictures Online Shapes 3 My Add-ins - Wikipedia  Online Links  Comment

- - Pictures ~ @+ Screenshot~ CulLgy Video - [#] Page Number~ Box~ & -

Tables Ilustrations Add-ins Media Comments Header & Footer Text A
L ]'"""‘g"‘hddachart N R BRI SR R SR
- 5 Make it easy to spot patterns and
- . trends in your data by inserting a
bar, area, or line chart.
3

To insert a chart, click f ,

| P All Charts
Insert 9 Chart- _ eTeIImemore ™ Recent

w0 (B8R RA 0 99 08 Gd

Column
Line Clustered Column

Pie

Choose a chart start :
from the Insert Chart :
dialog box. Click OK. :

Bar

Area
XY (Scatter) II II III I

Stock

Surface

Radar
Treemap
Sunburst
Histogram
Box & Whisker
Waterfall

<+

FPEEFOEHXBEERMeE

Page1of1 Owords [ 8 Combo

oK Cancel
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Once you click OK, a
chart will appear in
your document, and a
small Excel spreadsheet
will pop up.

You can change the
values of your chart by
changing the sample
data in the spreadsheet
window.
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CHARTS

Document2 - Word

Referenc (=3 Mailings Review View Format Q Tellme.. Desimone, Elizabeth

(] — = =
a =M ~ = &5
B o oo bbbl pdul Bkl bduil - SE L
Add Chart Quick | Change |- IEUEREMEY i i 1 li E=sbs MeldiHl 0 1 7 SwitchRow/ Select Edit Refresh  Change
Element ~ Layout~ Colors ~ Column  Data Datar Data  Chart Type
Chart Layouts Chart Styles Data Type ~
L Lo E ------ 1. .. 2. .. 3. ... 4 g N 6 AT -]
1% 0=
. . Ha¥
- Chart Title =
- 6 +
- 5 Y
- -~
: 4 I I |
) 3
: 1 I I I
: 0
" Category 1 Category 2 Category 3 Category 4
MSeries 1 MSeries2 M Series3

-

. A B (c D E F G H | |~
LNE e 03 4 Series1 Series2 Series3 1o

2 |Categoryl 4.3 24 2

3 |category 2 2.5 a4 2

4 |category 3 3.5 18 3

5 |Category 4 4.5 2.8 5

6

= v
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CHARTS

Design Tab

Add data labels, axis titles,

Apply a preset formatting style
legends, etc.

Switch to a different
kind of chart (bar, pie,
line, etc.)

Change your data

Choose a color scheme

Eh' @ﬁ[:]:

Docurment2 - Word

File Home Insert Design Layout References Mailings Review View Format Q Tell me what you want to do...

I @Y e ) T B2 1l
Add Chart Quick Change |“ Il' I" II |I| I|[ m ||‘ : -lL-ll-—lI-M ﬂ l-“ fh [h I" llllll Ill ’“ Il' '! |I| Switch Row/ Select Edit Refresh Change
Element ~ Layout~ Colors ~ Column Data Data~ Data  Chart Type

Chart Layﬁts Chart Styles Data Type

Switch your x and y axes

Choose from preset layouts
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CHARTS

Format Tab. (Similar to Drawing Tools Tab.)

Insert shape Customize WordArt

Apply custom formatting Change size of shape

H ©- E’: - 0 - hart Tool Document2 - Word

File Home Insert Design Layout References Mailings Review s Q Tell me what you want to do..

Horizontal (Category) A: ~ NN

L2 Shape Fill - A Text Fill - E 2 [& Align~ 1 ap T
&,-I Format Selection OocO - \ \ v [__‘ Shape Outline ~ A A _ v ﬂ Text Outline ~ Uk Group .
ange

T Reset to Match Style ALLF ih ¥ (& Shape Effects 7] [\ Text Effects - Position :VHF., ;Crw;u F,.\l’:] Se:je::ieon' \ Rotate S
Current Selection Insert Shapes . f Shape Styles [ / WordArt Styles ] - Arrange Size
Apply preset formatting Insert WordArt Arrange shapes on page or in relation to each
other
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To insert a table into a
Word document, click
Insert 2 Table.

Option 1: Move mouse

over squares in grid; click.

Option 2: Click Insert
Table and put in the
number of columns and
rows in the dialog box.
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TABLES

HS-0OQl=DO -

File Home

==

Pages | Table Pictures Online Shapes

Design

- Pictures -

Tx6 Table

I
I O

M Insert Table...
™ Draw Table

E['g Excel Spreadsheet
B Quick Tables

Owords  [[2

E%DDDDDD

I O
I

Layout

Document1 - Word

References Mailings Review View

@ Tell me what you want to do...

1ocr E’ﬂ L - = =
ﬁStore g % [] Header = |}' Q
11 Chart ) [2] Footer~ 4-0B
3 My Add-ins - Wikipedia  Online Links ~ Comment Text Symbols
4 Screenshot - @ v Video - [#] Page Number - Box~ T M
Add-ins Media Comments Header & Footer Text
------- F IR - R T R A SRR R SRR SRR B . 7
Insert Table [ ? H = |
Table size
Number of columns: S -
Number of rows: 2 el
AutoFit behavior
(®) Fixed column width: |Auto =

(O AutoFit to contents
(O AutoFit to window

[[] Remember dimengions for new tables

Cancel

Desimone, Elizabeth ,q_ Share

00%




TABLE TOOLS TAB

Design Tab

Add a Header Row at

the top of your table Customize table appearance

Add a Total Row at the
bottom of your table Choose a preset table style

HS - 0OR@@®D -

Document1 - Word

File Home Insert Design Layout References Mailings Review i i Layout Q Tellme.. Desimone, Elizabeth ,q_ Share
| Header Row  |v! First Column TEEEm | —==l==]  [==l==]= T e 63 — -F i W -4
e | =22z EEzz2 ===== ===== :-:-::: A | iy
Total Row Last Column SEEEE | EEEEE] EEEEE ===== —|==== ZZZZZ2 [Yeninn Y2 pt ~ o 4
SEEEE | SI2EEE SEEEE === ZIE--Z- ZZZZ:C — Shading Border —; Borders Border
| Banded Rows Banded Columns - S Styles ~ r_’ Pen Color ~ BN D ainter
\Lable Style O$ions Table Styles Borders A

Alternate shading between rows or columns
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TABLE TOOLS TAB

Layout Tab

Delete or Insert rows or columns ) )
Align text in a cell

Open Table Properties
dialog box

H ©-0 @ - 0O - Document]1 - Word Table Tool i

File Home Insert Design Layout References Mailings Review View Q Tell me... Desirr

[} Select~ ™ Draw Table [ ] I P E Insert Below Merge Cells | § [1/0.19" B BIBE A:. @ e
fEH View Gridlines “*| Eraser . €1 Insert Left Split Cells ? 1.3" - H BEE —
) = Delete Insert ) E A ) :: . = Text Cell Data
r|'3 Properties - Above 3 Insert Right = Split Table = AutoFit ~ EE&HE Direction Margins -
Table Draw Rows & Columns ] Merge Cell Size ] Alignment
Draw or erase table lines Merge or split cells
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MAIL MERGE

H -0 @ - 0 - Document1 - Waord Chart Tools Table Tools

File Home | Insert | Design | Layout | References |QENILIEE Review | View | Design Format Design Layout Q Tellme.. Desimone.. ,Q_.Share

F‘ ’7 Rules >
1 ljl El E.. Match Fields . Find Recipient
TO u Se t h e IVI a I I IVI e rge Envelopes Labels = Start Mail Select Edit Highlight Address Greeting Insert Merge Preview Finish &

Merge = | Recipients - Recipient List | Merge Fields Block  Line Field Update Labels | pegylts Check for Errors Merge
Wizard, cick Mailings > |, = L
-mail Messages -
. : Mail Merge V&
Start Mail Merge 2> : E3 Enclope
- l__‘D Labels. Select document type
. R
Step by Step Mail Merge : B iectory -
- N El MNormal Word Document ®) Letters
lea rd- . @ Step-by-Step Mail Merge Wizard... E-mail messages
~N . 5 Envelopes
. [Company] Labelsp
- [Street Address] ;
n [City, 5T Zip Code] Directory
L
Then follow the - L s
rt. group of

people. You can personalize

instructions in the panel 3

Here ore the results of our cookie sale: Click Next to continue.

on the right side of the . .
window. : 2

Cookie Sales

Step1ofb
. &0 = Next: Starting document
n
- = ]
Page1of2  S6words @ & B B - 1 + 9%
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MAIL MERGE

Mail Merge ~ ~ %

Select document type

What type of document are
you working on?

®) Letters
E-mail messages
Envelopes
Labels
Directory

Letters

Send letters to a group of
people. You can personalize
the letter that each person
receives,

Click Next to continue.

Step10of6
->» Next: Starting document

Mail Merge ™ X

Select starting document

How do you want to set up
your letters?

@) Use the current document
Start from a template
Start from existing document

Use the current document

Start from the document
shown here and use the Mail
Merge wizard to add
recipient information.

Step 2 of 6
=>» Next: Select recipients

€ Previous: Select document ty

Mail Merge s

Select recipients
@) Use an existing list

Select from Outlook contacts
Type a new list
Use an existing list

Currently, your recipients are
selected from:

[Office Address List] in "My Addre
[C] select a different list...

[+ Edit recipient list...

Step 3 of 6
=>» Next: Write your letter

€ Previous: Starting document

Mail Merge Recipients

This is the list of recipients that will be used in your merge. Use the options below to add to or change your list.
Use the checkboxes to add or remove recipients from the merge. When your list is ready, click OK.

My Addresses.mdb [IEdll Flintstone

My Addresses.mdb [V  Rubble Barney Mr. 37 Sto
My Addresses.mdb [V Quarry Rock Mr. Rock Studios 1 Quar
My Addresses.mdb [V Slate George Mr. The Slate Rock and Gra... 27 Slat
< >
Data Source Refine recipient list

My Addresses.mdb 2| sott...
T Elter...

%3 Find duplicates...
(O Find recipient...

[ validate addresses...
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Mail Merge ~ ¥ %

Write your letter

If you have not already done
50, write your letter now.

To add recipient information
to your letter, click a location
in the document, and then

click one of the items below.

D Address block...

[® Greeting line...

[j Electronic postage...
B More items...

When you have finished
writing your letter, click Next.
Then you can preview and
personalize each recipient's
letter.

Step 4 of 6
> Next: Preview your letters

€ Previous: Select recipients

MAIL MERGE

Insert Address Block
Specify address elements

@ Insert recipient’s name in this format:

Joshua
Joshua Randall Jr.
Joshua Q. Randall Jr.

Mr. Josh Randall Jr.
Mr. Josh Q. Randall Jr.

Mr. Joshua Randall Jr. v

@ Insert company name

[ Insert postal address:
() Never include the country/region in the address
O Always include the country/region in the address
(®) Only include the country/region if different than:
United States v

E Format address according to the destination country/region

Jefferson Parish Library

Insert Greeting Line X4
Greeting line format:

Dear |v| |Mr.Randall M L. v]
Greeting line for invalid recipient names:

Dear Sir or Madam, ZI
Preview

Here is a preview from your recipient list:

1 > M

Dear Mr. Flintstone,

Correct Problems

If items in your greeting line are missing or out of order, use Match Fields
to identify the correct address elements from your mailing list.

Match Fields... |

conce

o
‘sz

Preview

Here is a preview from your recipient list:

1 P M

Mr. Fred Flintstone
39 Stone Canyon Way
Bedrock, NV 12345

Correct Problems

If items in your address block are missing or out of order, use
Match Fields to identify the correct address elements from
your mailing list.

Match Fields...

o
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MAIL MERGE

Mail Merge ~ ™%

Preview your letters

One of the merged letters is
previewed here. To preview
another letter, click one of
the following:

Recipient: 1 |
[,_O Find a recipient...

Make changes

You can also change your
recipient list:

G‘ Edit recipient list...

Exclude this recipient

When you have finished
previewing your letters, click
Next. Then you can print the
merged letters or edit
individual letters to add
personal comments.

Step5of6
=> Next: Complete the merge
€ Previous: Write your letter

Mail Merge L

Complete the merge
Mail Merge is ready to
produce your letters.

To personalize your letters,
click "Edit Individual Letters.”
This will open a new
document with your merged
letters. To make changes to
all the letters, switch back to
the original document.

Merge
E‘.g, Print...

?'D Edit individual letters...

Step6of 6

€ Previous: Preview your letter:




MAIL MERGE

You can also conduct a mail merge
using the tools in the Mailings tab.

E‘?' EﬁﬁD:

Home Insert Design References Mailings View Layout Q Tell me... Desimone, Elizabeth P+ Share
0 \ B -
Sk R 2 B BB S| - [RCEEARG
_ -~ ol = : T & Match Fields ~  [DFind Recipient 5
Envelopes Labels Start Mail  Select Edit Highlight Address Greeting Insert Merge Preview Finish &
Merge ~ Recipients ~ Recipient List Merge Fields Block  Line Field - Update Labels  'Recults [ Check for Errors Merge ~
Create Start Mail Merge Write & Insert Fields Preview Results Finish A
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To insert a watermark,
click Design 2>
Watermark.

Click a preset watermark,
or click Custom
Watermark from the
menu.

Jefferson Parish Library

WATERMARK

Document] - Word

Layout References Mailings Review View Q Tell me what you want to do. Ne<imane Elizabeth Rshare
2 = e . THe M - e P [ ] 3eeoehspacns- 3 0
..... == == Veadig 1 e £== . . - Ef‘feds‘
Themes |=So0=m= | o St aemmnemer = — Colors Fonts Watermark jPage  Page
P mm—— - - bl B - @ Setas Default olor~ Borders
Document Formatting Page Bickground -~
L 1.......;,.‘.,‘,1‘”.‘.1‘,..,.‘3.‘,.‘,‘4....”.5,.‘..‘,5”.(_ |4
=
- Confidential ]
: CONFIDENTIAL 1 CONFIDENTIAL 2 DO NOT COPY 1
~
X DO NOT COPY 2
- Disclaimers
-
. -
Pagelof1 Owords [2 23 B - 1 +  100%
DRAFT 1 DRAFT 2 SAMPLE1 -
@ More Watermarks from Office.com »
[l Custom Watermark...
[ Remove Watermark




WATERMARK

Choose a picture watermark or a text watermark.

Printed Watermark ’I”E Printed Watermark i il
(O No watermark (O No watermark
(®) Picture watermark (O Picture watermark
Select Picture... Select P
Scale: Auto z [ washout Scale: Auto | Washout
(O Text watermark (® Text watermark
language: |English (United States) Language:  English (United States) v
Text: ASAP _ Text: ASAP v
Font: Calibri ' Font: Calibri V]
Size: Auto Size: Auto E
Color: Automatic ‘ Semitransparent Color: Z] ] Semitransparent
Layout: Diagonal Horizontal Layout: ® Diagonal () Horizontal

pply 6}, Cancel Apply Cancel

Jefferson Parish Library




WATERMARK

Insert Pictures ®© e
:& From a file Browse »
l) Bing Image Search bird of paradise
& OneDrive - Personal Browse » You Ca n Inse rt a
picture watermark
- from a file, from your
Online Pictures © .
1 Search Bing OneDrive account, or
Powered by |» Bing from Online'
Y [4 Creative Commeons only

You are responsible for respecting others' rights, including
copyright. Learn more here

Cancel
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WATERMARK

Review View Q Tellme...

Desimone, Elizabeth ,O+ Share

Colors Fonts

Once a picture ;
watermark is inserted,
you can choose the
scale and level of
washout.

Printed Wa

mark

[m
&

O No watermark
(®) Picture watermark

- . @ Setas Default

Document Formatting

_55‘ Paragraph Spacing ~
Effects =

B e & -—

® & 0

Watermark Page Page

Color ~ Borders
Page Background A~

+ 100%

_ Select Picture... = (Existing watermark)
Scale: 100% Q ] washout
O Text watermark
Language: |English (United States)
Text: ASAP
Font: Calibri &
Size: Auto
Color: Automatic | Semitransparent
Layout: Diagonal Horizontal

Cancel
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WATERMARK

H ©- @ = D

Home Insert Layout  References  Mailings  Review  View

Q Tell me... Desimone, Elizabeth
Aaj Tile TITLE . Title TITLE n =# Paragraph Spacing ~ D @ D
2o [ — | Effects~

— Colors Fonts

Watermark Page Page
« @ Setas Default

Color ~ Borders

Document Formatting Page Background ~

You can choose a
preset text
watermark or a
custom text I
watermark. O e mimmert

O Picture watermark

Scale: Auto Washout
(®) Text watermark

Language: | English (United States) Zl
Text: Jefferson Parish Library E[

Page1of1 Owords [|2 83 Eont Algerian z[
Size: Auto E

Color: I | (] semitransparent
layout: (@ Diagonal (O Horizontal

Cancel
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ADDITIONAL RESOURCES

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* From the JPL homepage, click on the Digital Content Tutorials * After the course menu opens, click Full Screen
(blue rectangle) next scroll bar. at the top of the course menu to view tutorials.

«” Full Screen % Close

& Jefferson
. Select Langu v
w = Jm Parish l’j volWw [find books, DvDs, and more... |l Seanch | T

Library JPL Digital Content Tutorials 2

Home | Locations < | Services v‘ Reference = | Policies — | Library Info = | ILL ‘ Catalo Digital Content | Databases | Childrens/Teens/Adults <> | Calendars | Contact Us <

D Find Books, DVDs
A CDs, and more in the @ Online Databases
Catalog Search NOTICE: Repairs require tempora, ¢
Bl Gisa entrance at East Bank Regional a Ask a ibrarian (- 1 **Click and Learn JPL Digital Content Apps >
- Users of East Bank Regional Library » e
Jﬁl. Log.in to your must enter through the administration +4‘3—WL |
account

entrance on the right side of the library.

Computer Classes Adult | eaming

(Brainfuse) s of East Bank Regiona ! **|PL's Basic Computer Skills Learning Guide >

@ Your Library Click fiere formore information Besources (Brainfuse) on the right side of *Homework Louisiana (Tutor.com) Tutorial - Real
f ‘ Free Online Tutoring . s >
\ Text-a-Librarian Q) for K-12 and College ; experts, waiting to help you now
| S ) -k here for more inforr

] Get email reminders
ﬁO_Liuﬁ_i‘aEE

Search the collection
Research Library

. In‘ter-ne't -
, *Internet Basics >

*Joining Cisco Webex Meetings >

Information for all
Jefferson Parish Libraries

1
Belcume a Teen
~ | Volunteer « The Jefferson Parish Library is open to the public, but hours (Pronunciator) H
*
may vary by branch. Patrons can request and reserve items %ﬂ;ﬁ ) |format|0n fO Learn to Use Your Chromebook >
to pick up via curbside service or inside via self-checkout or (Mange) I Lox . .
HOWTO counter service. Distanced computers will be available for rson Pa Fis h LI

RENEW ITEMS: use by advanced reservation and distanced seating will be *Zoom - Let's learn to use it! >

available inside for patrons use. Parish Library is open to tk

ranch. Patrons can reques
curbside service or inside
e. Distanced computers v

‘ed reservation and distan [y Ancestry Library Edition Tutorial -- Access Billions
le for patrons use 1t ¥ ; >
2o of Genealogical Records

1. Online thru
Online thru = Meeting and study rooms will be open, but are subject to
your account AR e
the capacity limitations established by the State of Louisiana
2. Call TeleCirc at & Jefferson Parish. Patrons must wear a face covering or
5 mask (which covers both the nose and mouth) and undergo
(504) 885-8588 a temperature screening prior to entering.

Advanced Internet Search Techniques >

L.
+ Single and larger study rooms will be available with limited itudy rooms will be open,
capacity and time management. mitations established by t AtOZ World Food >
- . ol
* A reservation for a meeting room is required. There will be rish. Patrons must wear a
a limited capacity for each individual meeting room due to :overs both the noseand r g

ial distancing. Click here fi ti ities. 5 st i - i
| soca distancing. Click here for meeting room capaciti y o » y screening prior to enterif . Auto Repair Source - Automotive Information >
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ADDITIONAL RESOURCES

* From the library’s homepage, click on the JPL Digital
Content link or the Digital Content menu tab.

[ Jefferson Parfh Library

Jefferson
Parish
Library

ol ¥

Catalog | Digital Content

Catglg Search

JPL Digital Content

my, Log in to vour
account

Read full digital copies of your
favorite magazines on a computer,
tablet, or mobile device using the
free Zinio Reader app!

I Computer Classes
2| @ vour Library

Text-s-Librarian

Click here for more information.
] [ 2 |

Through our website, patrons now have unlimited multi-user sccess to
complete digital magazines, which can easily be viewed on most

@] Get email reminders
__\ for due dates

Search the collection
ofthe American
Italian Research
| Library

Jefferson Parish Library

Additional helpful resources can be accessed through our homepage www.jplibrary.net

* Then click on the LinkedIn Learning icon to access

online training using your library card number and pin.

[vVopy CETETEETEE T

Y
i Jefferson
Library

Home Locations = | Services 7 Wglerence ©  Poldes =

Uibrary Tnfo | TLL | Catabg | Digital Content Databases | Chikdrens/Teens/Adults = | Calendars =~ Contact Us =

o A
Download eBoaks & Audiobooks

freegal

i
Over 30,000 v

ol 1R
Download Music for Free  O¥e[30.0005

TumbleBook
\ipror!

K-3 Books Online
creativebug

CHECK
ITOUT @ d
(F )

Linkedin Leaming
Online Training Videos

gital Content Tutorials

<




NOTES

Jefferson Parish Library authorizes you to view and download materials such as this handout at our web site (www.jplibrary.net) only for your personal, non-commercial
use, provided that you retain all copyright and other proprietary notices contained in the original materials on all copies of the materials. You may not modify the
materials at this site in any way or reproduce, publicly display, perform, distribute or otherwise use them for any public or commercial purpose. The materials at this site
are copyrighted and any unauthorized use of any materials at this site may violate copyright, trademark, and other laws. If you breach any of these Terms, your
authorization to use any materials available at this site automatically terminates and you must immediately destroy any such downloaded or printed materials.
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